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1 OVERVIEW 
The RST Readout Host Software was designed to allow easy download and display of data from the 
compatible readouts to PC’s running Microsoft Windows. The user friendly graphical interface lets the 
user to view all data contained in readout memory and enables modification of any options and 
presets offered by the instrument. 

2 QUICK START INSTRUCTIONS 
The following instructions outline the basic steps needed to take and store readings with the Readout 
Host Software with the appropriate references to sections in the manual: 

• Install the RST Readout Host Software on a Desktop or Laptop PC (section 3.1). 

• Connect to the compatible Readout via a USB port (section 3.3). 

• Using the software, enter the list of locations as they appear on site (section 4.1, 5.1, 6.1, 
7.1, 8.1, 9.1,10.1). 

• Upload the information to the readout (section 4.2, 5.2, 6.2, 7.2, 8.2, 9.2,10.2) 

• Take the readout to the field and record readings in the locations that were setup with the 
software. 

• When finished, return to the office, connect to the readout with the host software and 
download the data (section 4.3, 5.3, 6.3, 7.3, 8.3, 9.3,10.3). 

• Save downloaded data to the csv formatted file as prompted by the software. This will 
ensure that data is not accidentally erased from readout resulting in data being lost. 

• Make any changes (if needed) and upload locations configuration to the readout (section 4.2, 
5.2, 6.2, 7.2, 8.2, 9.2,10.2).  During the upload, the software will prompt if you would like to 
erase all data on the readout except previous readings.  Erasing the historical data ensures 
that data will not be duplicated in the *.csv file the next time the readout data is downloaded. 

• Close the RST Readout Host program. 

• Open the *.csv file created by the software with Microsoft Excel, sort and plot the data 
(section 12.1.2). 
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3 RST READOUT HOST SOFTWARE 
3.1 GETTING STARTED 

Insert the RST Readout Host Software CD-ROM and follow the on-screen instructions for installing 
the software.  The default directory for the software is: 

C:\Programs Files\RST Instruments\RST Readout Host 

This directory can be changed if desired. 

Very Important 
Ensure that USB to UART Device Driver Set is installed correctly, as described in Section 14 or 
Section 15. These drivers are necessary for correct communication between host computer and the 
readout. 

 

3.2 OPENING SCREEN 
Upon first launch of the program, the following screen will appear: 

 

 

Figure 1 – RST Readout Host Software Opening Screen 
The workspace screen consists of a menu and toolbar at the top, and a blank workspace beneath. 

If the readout is connected via the USB port, the software automatically senses a connection and will 
prompt to download the data from readout memory.  

Status 
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3.3 STATUS BAR 
Please note the location of the status bar at the bottom of the screen (Figure 1).  The program will 
continuously try to connect to the readout even if the unit is not powered on.  To connect to the 
readout, remove the dust cover from the USB port connector and plug in the supplied USB cable.  
Plug the other end of the USB Cable into the USB port of the host computer. 

The software automatically detects USB port settings.  If problems are encountered, please refer to 
section 16 (Troubleshooting). 

Power on the readout by pressing any key.  The status bar connection indicator should change from 
Connecting to Connected (Figure 1).  The software should prompt you if you would like to download 
the data.  After data download, it will prompt you to save data into csv comma separated file.  For 
more information on the file types the host software creates, please refer to section 12. 

The download progress will be indicated on the left side of the status bar. 

Note 
It is highly recommended to save downloaded data to csv formatted data file. This will ensure that 
data is not accidentally erased from readout resulting in data being lost. 
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4 VW2106 READOUT 
4.1 CREATING VW2106 LOCATIONS 

Right-click anywhere in the blank workspace to create a new location or click on Add Location toolbar 
button. 

 

 

Figure 2 – Creating a New VW2106 Site 
Click on New Location and the following dialog box will appear: 

 

Figure 3 – Naming VW2106 Location 
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Enter in an appropriate location name.  In this example the location is: BH2005-ba.  The location 
name can be any alpha-numeric character up to 20 characters long.  This allows the option of 
entering a detailed name.  

Important 
Location name, sensor label and sensor serial cannot contain any comma (“,”) characters. Using 
comma characters in any label string would interfere with CSV data file formatting. 

 

Select the number of VW sensors (between 1 and 6) for this Readout location. When sensor number 
is set to No Expansion, one sensor can be connected to Readout terminals. Between 1 to 6 sensors 
can be connected to expansion connector (i.e. loadcell). 
Select appropriate Vibrating Wire Sweep and Thermistor Type. The Eng Calibration and Advanced 
functions are explained in section 4.5 Advanced settings. Subsequent Locations can be created by 
repeating the above procedure. 
 

 

Figure 4 – Creating VW2106 Locations 
Figure 4 shows five locations which have been created and contain no current or historical readings.  
These locations still need to be uploaded to the readout device at this stage. 

In order to delete any existing location, put a checkmark in first column checkbox and click Delete 
checked toolbar button. 

Current locations and configuration can be saved to ini file for future use or upload to the readout. 
Choose Save As.. from File menu to save currently displayed locations to site configuration file.  
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4.2 UPLOADING VW2106 SITE INFO 
For the following procedures, it is assumed that the readout has established a successful connection 
to the host computer and the status Connected is displayed on the status bar.  

The following steps will clear Readout data memory and prepare Readout for next data 
collection in field. Therefore ensure that any existing data was exported to csv data file. 
(section 12.1.2).  
Click on Upload Site Info to upload the current information from the RST Readout Host software to 
the readout.  Upon uploading the data, the program will prompt you to if you would like to erase the 
current data on the readout.  In the normal progression of the program, erasing the existing data is 
the appropriate step. The latest recorded value from each location is saved as Previous Record 
Value.  

 

 

Figure 5 – Uploading VW2106 Sites 
Note 

Always press the Upload Sites button before exiting the program as this ensures that data will not 
be duplicated in the subsequent *.csv file.  If no changes have been made to the setup, select NO 
when the program prompts you to save changes to the *.ini file. 

 
Once the custom user-defined locations are uploaded, the readout is ready to be taken out to the 
field to record data. 
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4.3 DOWNLOADING VW2106 DATA 
Once the readings have been taken in the field, the data must be downloaded to the host software.  
Connect the readout to the Computer via the USB cable.  Launch the software and connect to the 
readout (section 3). 

 

Figure 6 – Downloading VW2106 Data 
Upon connection, the software will automatically prompt the user to download and save the data.  To 
perform a manual download press the Download Data button in the toolbar.  

Note 
Downloaded data is not automatically saved into the data file by host computer. It is highly 
recommended to export data into csv file, as prompted by the host software. This will ensure that 
data is not accidentally erased from readout resulting in data being lost. 
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4.4 VIEWING VW2106 DATA 
Once the data has been downloaded, the workspace becomes populated with all the information as 
found on the readout. 

 

Figure 7 – Downloaded VW2106 Data 
As shown above, the data is populated and includes Location label, Previous Record Date/Time, 
Previous Record Value, Units and Number of saved readings for each location.   

4.4.1 VIEWING VW2106 LOCATION READINGS 
A complete listing of readings for selected location can be seen by clicking on the Display Records 
button in the toolbar. The sample data is shown below. This is the data currently contained on the 
readout itself, not necessarily all the historical data you might have for that location.  The scroll bar at 
the right of the screen permits the user to scroll and view all the readings for a particular location. To 
quickly jump to viewing another location, click on Previous or Next buttons. 
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Figure 8 – VW2106 Location Data Display 

4.5 ADVANCED VW2106 SETTINGS 
4.5.1 VIBRATING WIRE TYPE ADVANCED PARAMETERS 

Each location’s Vibrating Wire Type can be set to any of the predefined types: A, B, C, D, E, F. For 
fine tuning of vibrating wire parameters, choose U Custom (Advanced) option from pull-down menu 
(Figure 9). 

 

Figure 9 – Vibrating Wire Advanced Settings 
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Figure 10 – Decrement and Sweep Time options 
Edit the required fields if necessary, and click Edit Sweep to determine the remaining parameters. 
Enter the desired Sweep Time and click Recalc. The program will calculate Decrement and Sweep 
Time and give option to choose optimal parameters.Press Load Defaults to load default parameters. 
After modifying parameters, click Save Custom to save one custom vibrating wire type for future 
retrieval. This custom type can be loaded to any location settings by pressing Load Custom button.  
Each location can have its own vibrating wire settings. Modify parameters in the above dialog and 
click OK to save changes. 

4.5.2 ENGINEERING UNITS 
Often the user may wish to report the readings directly in engineering units, rather than B-units 
(f2x103).  Data required for the conversion to engineering units is always found on the calibration 
sheets for the transducer. 

Each transducer is shipped from the factory with a calibration sheet.  If you have not received a 
calibration sheet, or the sheet has been lost, please contact RST Instruments and a copy will be 
faxed or e-mailed to you. 

Engineering units conversion settings can be modified using the Eng Calibration dialog box shown in 
Figure 11. Access to this dialog box is provided from Edit Location dialog box. 
 
Conversion Method 

The user is given an option to apply either a Linear or Polynomial Conversion.  If linear conversion in 
selected, input the provided Calibration Factor and Zero Reading into the appropriate boxes. 

If polynomial conversion is selected, input the provided coefficients (A, B & C) into the appropriate 
boxes. 

In each case, equations used for calculations are shown for a reference. 

Note 
In each location settings, either linear or polynomial conversion coefficients can be saved. 

 



RST Readout Host Software Instruction Manual 

RST Instruments 

18 

 

Figure 11 – Engineering Units settings 

Temperature Correction 

When the Enable Temperature Correction box is checked, the software will apply a temperature 
correction to the data.  This requires the user to enter in the temperature correction factor and an 
initial temperature which is found on the calibration sheet for that particular instrument. 

If the calibration sheet is missing, please contact RST Instruments and a copy of the calibration sheet 
can be faxed or e-mailed to you. 
 
Units Conversion 

Units Type: Choose pressure or distance using the drop-down menu. 

Input Units: These are the units of the calibration constants you inputted into either the linear 
conversion or polynomial conversion methods.  In general, the calibration constants reported on the 
calibration sheets are either in kPa/B unit or psi/B unit.  In the case of strain gauges, this could be 
mm/B unit. 

Output Units: Select the appropriate output units from the drop-down list. 

Output Zero: This is a user defined offset value.  Under certain circumstances, the user may wish to 
enter in the elevation of the pressure transducer.  In this way the reported pressure will be correlated 
to a reference elevation (i.e. above sea level). 

Important 

Whenever ANY changes are made on the Engineering Units screen or Edit Location dialog box, the 
Upload Site Info button must be pressed in order to update the readout with new information. 
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5 TH2016 AND TH2016B READOUT 
5.1 CREATING TH2016 LOCATIONS 

Right-click anywhere in the blank workspace to create a new location or click on Add Location toolbar 
button. 

 

 

Figure 12 – Creating a New TH2016 Site 
Click on New Location and the following dialog box will appear: 

 

Figure 13 – Naming TH2016 Location 
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Enter in an appropriate location name.  In this example the location is: TH2006-ba.  The location 
name can be any alpha-numeric character up to 20 characters long.  This allows the option of 
entering a detailed name.  

Important 
Location name, sensor label and sensor serial cannot contain any comma (“,”) characters. Using 
comma characters in any label string would interfere with CSV data file formatting. 

 

Select the number of temperature sensors (between 1 and 16) for this Readout location. One sensor 
can be connected to Readout terminals, 1 to 16 sensors can be connected to expansion connector. 
Select the appropriate Thermistor Type. If required, enter correction and sampling delay values for 
selected sensors. See section 13.1.2 for setting default sampling delay. Subsequent Locations can 
be created by repeating the above procedure. 
 

 

Figure 14 – Creating TH2016 Locations 
Figure 14 shows five locations which have been created. These locations still need to be uploaded to 
the readout device at this stage. 

In order to delete any existing location, put a checkmark in first column checkbox and click Delete 
checked toolbar button. 

Current locations and configuration can be saved to ini file for future use or upload to TH2016 
Reader. Choose Save As.. from File menu to save currently displayed locations to site configuration 
file.  
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5.2 UPLOADING TH2016 SITE INFO 
For the following procedures, it is assumed that the TH2016 Readout has established a successful 
connection to the host computer and the status Connected is displayed on the status bar.  

The following steps will clear Readout data memory and prepare Readout for next data 
collection in field. Therefore ensure that any existing data was exported to csv data file. 
(section 12.1.2).  
Click on Upload Site Info to upload the current information from the TH2016 Host software to the 
Readout.  Upon uploading the data, the program will prompt you to if you would like to erase the 
current data on the readout.  In the normal progression of the program, erasing the existing data is 
the appropriate step. 

 

 

 

Figure 15 – Uploading TH2016 Sites 
Note 

Always press the Upload Site Info button before exiting the program as this ensures that data will 
not be duplicated in the subsequent *.csv file.  If no changes have been made to the setup, select 
NO when the program prompts you to save changes to the *.ini file. 

 
Once the custom user-defined locations are uploaded, the readout is ready to be taken out to the 
field to record data. 
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5.3 DOWNLOADING TH2016 DATA 
Once the readings have been taken in the field, the data must be downloaded to the host software.  
Connect the TH2016 Readout to the Computer via the USB cable.  Launch the software and connect 
to the readout (section 3). 

 

 

Figure 16 – Downloading TH2016 Data 
Upon connection, the software will automatically prompt the user to download and save the data.  To 
perform a manual download press the Download Data button in the toolbar.  

Note 
Downloaded data is not automatically saved into the data file by host computer. It is highly 
recommended to export data into csv file, as prompted by the host software. This will ensure that 
data is not accidentally erased from readout resulting in data being lost. 
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5.4 VIEWING TH2016 DATA 
Once the data has been downloaded, the workspace becomes populated with all the information as 
found on the TH2016 Readout. 

 

Figure 17 – Downloaded TH2016 Data 
As shown above, the data is populated and includes Location label, Sensor number, Thermistor 
Type, and Number of saved readings for each location.   
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5.4.1 VIEWING TH2016 LOCATION READINGS 
A complete listing of readings for selected location can be seen by clicking on the Display Records 
button in the toolbar. The sample data is shown below. This is the data currently contained on the 
readout itself, not necessarily all the historical data you might have for that location.  The scroll bar at 
the right of the screen permits the user to scroll and view all the readings for a particular location. To 
quickly jump to viewing another location, click on Previous or Next buttons. 

 

Figure 18 – TH2016 Location data display 
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6 MA7 READOUT 
6.1 CREATING MA7 LOCATIONS 

Right-click anywhere in the blank workspace to create a new location or click on Add Location toolbar 
button. 

 

 

Figure 19 – Creating a New MA7 Site 
Click on New Location and the following dialog box will appear: 

 

Figure 20 – Naming MA7 Location 
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Enter in an appropriate location name.  In this example the location is: BM2006-ba.  The location 
name can be any alpha-numeric character up to 20 characters long.  This allows the option of 
entering a detailed name.  Optionally, each sensor can have individual name and serial number.  

Important 
Location name, sensor label and sensor serial cannot contain any comma (“,”) characters. Using 
comma characters in any label string would interfere with CSV data file formatting. 

 

Subsequent Locations can be created by repeating the above procedure. 
 

 

Figure 21 – Creating MA7 Locations 
Figure 21 shows five locations which have been created and contain no current or historical readings.  
These locations still need to be uploaded to the readout device at this stage. 

In order to delete any existing location, put a checkmark in first column checkbox and click Delete 
checked toolbar button. 

Current locations and configuration can be saved to ini file for future use or upload to the readout. 
Choose Save As.. from File menu to save currently displayed locations to site configuration file.  
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6.2 UPLOADING MA7 SITE INFO 
For the following procedures, it is assumed that the readout has established a successful connection 
to the host computer and the status Connected is displayed on the status bar.  

The following steps will clear Readout data memory and prepare Readout for next data 
collection in field. Therefore ensure that any existing data was exported to csv data file. 
(section 12.1.2).  
Click on Upload Site Info to upload the current information from the RST Readout Host software to 
the readout.  Upon uploading the data, the program will prompt you to if you would like to erase the 
current data on the readout.  In the normal progression of the program, erasing the existing data is 
the appropriate step. The latest recorded value from each location is saved as Previous Record 
Value.  

 

 

Figure 22 – Uploading MA7 Sites 
Note 

Always press the Upload Sites button before exiting the program as this ensures that data will not 
be duplicated in the subsequent *.csv file.  If no changes have been made to the setup, select NO 
when the program prompts you to save changes to the *.ini file. 

 
Once the custom user-defined locations are uploaded, the readout is ready to be taken out to the 
field to record data. 



RST Readout Host Software Instruction Manual 

RST Instruments 

28 

6.3 DOWNLOADING MA7 DATA 
Once the readings have been taken in the field, the data must be downloaded to the host software.  
Connect the readout to the Computer via the USB cable.  Launch the software and connect to the 
readout (section 3). 

 

Figure 23 – Downloading MA7 Data 
Upon connection, the software will automatically prompt the user to download and save the data.  To 
perform a manual download press the Download Data button in the toolbar.  

Note 
Downloaded data is not automatically saved into the data file by host computer. It is highly 
recommended to export data into csv file, as prompted by the host software. This will ensure that 
data is not accidentally erased from readout resulting in data being lost. 
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6.4 VIEWING MA7 DATA 
Once the data has been downloaded, the workspace becomes populated with all the information as 
found on the readout. 

 

Figure 24 – Downloaded MA7 Data 
As shown above, the data is populated and includes Location label, Previous Record Date/Time, 
Previous Record Value, Units and Number of saved readings for each location.   
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6.4.1 VIEWING MA7 LOCATION READINGS 
A complete listing of readings for selected location can be seen by clicking on the Display Records 
button in the toolbar. The sample data is shown below. This is the data currently contained on the 
readout itself, not necessarily all the historical data you might have for that location.  The scroll bar at 
the right of the screen permits the user to scroll and view all the readings for a particular location. To 
quickly jump to viewing another location, click on Previous or Next buttons. 

 

Figure 25 – MA7 Location Data Display 
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7 QB120 READOUT 
7.1 CREATING QB120 LOCATIONS 

Right-click anywhere in the blank workspace to create a new location or click on Add Location toolbar 
button. 

 

 

Figure 26 – Creating a New QB120 Site 
Click on New Location and the following dialog box will appear: 

 

Figure 27 – Naming QB120 Location 
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Enter in an appropriate location name.  In this example the location is: BH2005-ba.  The location 
name can be any alpha-numeric character up to 20 characters long.  This allows the option of 
entering a detailed name.  Optionally, each sensor can have individual name and serial number.  

Important 
Location name, sensor label and sensor serial cannot contain any comma (“,”) characters. Using 
comma characters in any label string would interfere with CSV data file formatting. 

 

 The Eng Calibration and Advanced functions are explained in section 7.5 Advanced settings. 
Subsequent Locations can be created by repeating the above procedure. 
 

 

Figure 28 – Creating QB120 Locations 
Figure 28 shows five locations which have been created and contain no current or historical readings.  
These locations still need to be uploaded to the readout device at this stage. 

In order to delete any existing location, put a checkmark in first column checkbox and click Delete 
checked toolbar button. 

Current locations and configuration can be saved to ini file for future use or upload to the readout. 
Choose Save As.. from File menu to save currently displayed locations to site configuration file.  
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7.2 UPLOADING QB120 SITE INFO 
For the following procedures, it is assumed that the readout has established a successful connection 
to the host computer and the status Connected is displayed on the status bar.  

The following steps will clear Readout data memory and prepare Readout for next data 
collection in field. Therefore ensure that any existing data was exported to csv data file. 
(section 12.1.2).  
Click on Upload Site Info to upload the current information from the RST Readout Host software to 
the readout.  Upon uploading the data, the program will prompt you to if you would like to erase the 
current data on the readout.  In the normal progression of the program, erasing the existing data is 
the appropriate step. The latest recorded value from each location is saved as Previous Record 
Value.  

 

 

Figure 29 – Uploading QB120 Sites 
Note 

Always press the Upload Sites button before exiting the program as this ensures that data will not 
be duplicated in the subsequent *.csv file.  If no changes have been made to the setup, select NO 
when the program prompts you to save changes to the *.ini file. 

 
Once the custom user-defined locations are uploaded, the readout is ready to be taken out to the 
field to record data. 
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7.3 DOWNLOADING QB120 DATA 
Once the readings have been taken in the field, the data must be downloaded to the host software.  
Connect the readout to the Computer via the USB cable.  Launch the software and connect to the 
readout (section 3). 

 

Figure 30 – Downloading QB120 Data 
Upon connection, the software will automatically prompt the user to download and save the data.  To 
perform a manual download press the Download Data button in the toolbar.  

Note 
Downloaded data is not automatically saved into the data file by host computer. It is highly 
recommended to export data into csv file, as prompted by the host software. This will ensure that 
data is not accidentally erased from readout resulting in data being lost. 

 



RST Readout Host Software Instruction Manual 

RST Instruments 

35 

7.4 VIEWING QB120 DATA 
Once the data has been downloaded, the workspace becomes populated with all the information as 
found on the readout. 

 

Figure 31 – Downloaded QB120 Data 
As shown above, the data is populated and includes Location label, Previous Record Date/Time, 
Previous Record Value, Units and Number of saved readings for each location.   
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7.4.1 VIEWING QB120 LOCATION READINGS 
A complete listing of readings for selected location can be seen by clicking on the Display Records 
button in the toolbar. The sample data is shown below. This is the data currently contained on the 
readout itself, not necessarily all the historical data you might have for that location.  The scroll bar at 
the right of the screen permits the user to scroll and view all the readings for a particular location. To 
quickly jump to viewing another location, click on Previous or Next buttons. 

 

Figure 32 – QB120 Location Data Display 
 
7.5 ADVANCED QB120 SETTINGS 
7.5.1 ENGINEERING UNITS 

Often the user may wish to report the readings directly in engineering units, rather than uE-units.  
Data required for the conversion to engineering units is always found on the calibration sheets for the 
transducer. 

Each transducer is shipped from the factory with a calibration sheet.  If you have not received a 
calibration sheet, or the sheet has been lost, please contact RST Instruments and a copy will be 
faxed or e-mailed to you. 

Engineering units conversion settings can be modified using the Eng Calibration dialog box shown in 
Figure 33. Access to this dialog box is provided from Edit Location dialog box. 
 
Conversion Method 

The user is given an option to apply a Linear Conversion.  Input the provided Calibration Factor into 
the appropriate box. 

The option is also given to modify the zero reading. 

Equation used for calculations is shown for a reference. 
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Figure 33 – Engineering Units settings 
 

Important 

Whenever ANY changes are made on the Engineering Units screen or Edit Location dialog box, the 
Upload Site Info button must be pressed in order to update the readout with new information. 
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8 SG350 READOUT 
8.1 CREATING SG350 LOCATIONS 

Right-click anywhere in the blank workspace to create a new location or click on Add Location toolbar 
button. 

 

 

Figure 34 – Creating a New SG350 Site 
Click on New Location and the following dialog box will appear: 

 

Figure 35 – Naming SG350 Location 
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Enter in an appropriate location name.  In this example the location is: SG2011-BA.  The location 
name can be any alpha-numeric character up to 20 characters long.  This allows the option of 
entering a detailed name.  Optionally, each sensor can have individual name and serial number. 

Important 
Location name, sensor label and sensor serial cannot contain any comma (“,”) characters. Using 
comma characters in any label string would interfere with CSV data file formatting. 

 

The Eng Calibration and Advanced functions are explained in section 8.5 Advanced settings. 
Subsequent Locations can be created by repeating the above procedure. 
 

 

Figure 36 – Creating SG350 Locations 
Figure 36 shows five locations which have been created and contain no current or historical readings.  
These locations still need to be uploaded to the readout device at this stage. 

In order to delete any existing location, put a checkmark in first column checkbox and click Delete 
checked toolbar button. 

Current locations and configuration can be saved to ini file for future use or upload to the readout. 
Choose Save As.. from File menu to save currently displayed locations to site configuration file.  
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8.2 UPLOADING SG350 SITE INFO 
For the following procedures, it is assumed that the readout has established a successful connection 
to the host computer and the status Connected is displayed on the status bar.  

The following steps will clear Readout data memory and prepare Readout for next data 
collection in field. Therefore ensure that any existing data was exported to csv data file. 
(section 12.1.2).  
Click on Upload Site Info to upload the current information from the RST Readout Host software to 
the readout.  Upon uploading the data, the program will prompt you to if you would like to erase the 
current data on the readout.  In the normal progression of the program, erasing the existing data is 
the appropriate step. The latest recorded value from each location is saved as Previous Record 
Value.  

 

 

Figure 37 – Uploading SG350 Sites 
Note 

Always press the Upload Sites button before exiting the program as this ensures that data will not 
be duplicated in the subsequent *.csv file.  If no changes have been made to the setup, select NO 
when the program prompts you to save changes to the *.ini file. 

 
Once the custom user-defined locations are uploaded, the readout is ready to be taken out to the 
field to record data. 
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8.3 DOWNLOADING SG350 DATA 
Once the readings have been taken in the field, the data must be downloaded to the host software.  
Connect the readout to the Computer via the USB cable.  Launch the software and connect to the 
readout (section 3). 

 

Figure 38 – Downloading SG350 Data 
Upon connection, the software will automatically prompt the user to download and save the data.  To 
perform a manual download press the Download Data button in the toolbar.  

Note 
Downloaded data is not automatically saved into the data file by host computer. It is highly 
recommended to export data into csv file, as prompted by the host software. This will ensure that 
data is not accidentally erased from readout resulting in data being lost. 
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8.4 VIEWING SG350 DATA 
Once the data has been downloaded, the workspace becomes populated with all the information as 
found on the readout. 

 

Figure 39 – Downloaded SG350 Data 
As shown above, the data is populated and includes Location label, Previous Record Date/Time, 
Previous Record Value, Units and Number of saved readings for each location.   



RST Readout Host Software Instruction Manual 

RST Instruments 

43 

8.4.1 VIEWING SG35 LOCATION READINGS 
A complete listing of readings for selected location can be seen by clicking on the Display Records 
button in the toolbar. The sample data is shown below. This is the data currently contained on the 
readout itself, not necessarily all the historical data you might have for that location.  The scroll bar at 
the right of the screen permits the user to scroll and view all the readings for a particular location. To 
quickly jump to viewing another location, click on Previous or Next buttons. 

 

Figure 40 – SG350 Location Data Display 
 
8.5 ADVANCED SG350 SETTINGS 
8.5.1 ENGINEERING UNITS 

Often the user may wish to report the readings directly in engineering units, rather than mV/V-units.  
Data required for the conversion to engineering units is always found on the calibration sheets for the 
transducer. 

Each transducer is shipped from the factory with a calibration sheet.  If you have not received a 
calibration sheet, or the sheet has been lost, please contact RST Instruments and a copy will be 
faxed or e-mailed to you. 

Engineering units conversion settings can be modified using the Eng Calibration dialog box shown in 
Figure 41. Access to this dialog box is provided from Edit Location dialog box. 
 
Conversion Method 

The user is given two options to apply a Linear Conversion: 

- Coefficient Input, enter Calibration Factor BM and Zero Reading CZ. 

- Range Input.  Input voltage vrnge and engineering calibration limits into appropriate boxes. 

The option is also given to modify the sensor offset. 

Equation used for calculations is shown for a reference. 
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Figure 41 – Engineering Units settings 
 

Important 

Whenever ANY changes are made on the Engineering Units screen or Edit Location dialog box, the 
Upload Site Info button must be pressed in order to update the readout with new information. 
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9 IR420 READOUT 
9.1 CREATING IR420 LOCATIONS 

Right-click anywhere in the blank workspace to create a new location or click on Add Location toolbar 
button. 

 

 

Figure 42 – Creating a New IR420 Site 
Click on New Location and the following dialog box will appear: 

 

Figure 43 – Naming IR420 Location 
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Enter in an appropriate location name.  In this example the location is: IR2011-BA.  The location 
name can be any alpha-numeric character up to 20 characters long.  This allows the option of 
entering a detailed name.  Optionally, each sensor can have individual name and serial number. 

Important 
Location name, sensor label and sensor serial cannot contain any comma (“,”) characters. Using 
comma characters in any label string would interfere with CSV data file formatting. 

 

The Eng Calibration and Advanced functions are explained in section 9.5 Advanced settings. 
Subsequent Locations can be created by repeating the above procedure. 
 

 

Figure 44 – Creating IR420 Locations 
Figure 44 shows five locations which have been created and contain no current or historical readings.  
These locations still need to be uploaded to the readout device at this stage. 

In order to delete any existing location, put a checkmark in first column checkbox and click Delete 
checked toolbar button. 

Current locations and configuration can be saved to ini file for future use or upload to the readout. 
Choose Save As.. from File menu to save currently displayed locations to site configuration file.  
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9.2 UPLOADING IR420 SITE INFO 
For the following procedures, it is assumed that the readout has established a successful connection 
to the host computer and the status Connected is displayed on the status bar.  

The following steps will clear Readout data memory and prepare Readout for next data 
collection in field. Therefore ensure that any existing data was exported to csv data file. 
(section 12.1.2).  
Click on Upload Site Info to upload the current information from the RST Readout Host software to 
the readout.  Upon uploading the data, the program will prompt you to if you would like to erase the 
current data on the readout.  In the normal progression of the program, erasing the existing data is 
the appropriate step. The latest recorded value from each location is saved as Previous Record 
Value.  

 

 

Figure 45 – Uploading IR420 Sites 
Note 

Always press the Upload Sites button before exiting the program as this ensures that data will not 
be duplicated in the subsequent *.csv file.  If no changes have been made to the setup, select NO 
when the program prompts you to save changes to the *.ini file. 

 
Once the custom user-defined locations are uploaded, the readout is ready to be taken out to the 
field to record data. 
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9.3 DOWNLOADING IR420 DATA 
Once the readings have been taken in the field, the data must be downloaded to the host software.  
Connect the readout to the Computer via the USB cable.  Launch the software and connect to the 
readout (section 3). 

 

 

Figure 46 – Downloading IR420 Data 
Upon connection, the software will automatically prompt the user to download and save the data.  To 
perform a manual download press the Download Data button in the toolbar.  

Note 
Downloaded data is not automatically saved into the data file by host computer. It is highly 
recommended to export data into csv file, as prompted by the host software. This will ensure that 
data is not accidentally erased from readout resulting in data being lost. 
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9.4 VIEWING IR420 DATA 
Once the data has been downloaded, the workspace becomes populated with all the information as 
found on the readout. 

 

Figure 47 – Downloaded IR420 Data 
As shown above, the data is populated and includes Location label, Previous Record Date/Time, 
Previous Record Value, Units and Number of saved readings for each location.   
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9.4.1 VIEWING IR420 LOCATION READINGS 
A complete listing of readings for selected location can be seen by clicking on the Display Records 
button in the toolbar. The sample data is shown below. This is the data currently contained on the 
readout itself, not necessarily all the historical data you might have for that location.  The scroll bar at 
the right of the screen permits the user to scroll and view all the readings for a particular location. To 
quickly jump to viewing another location, click on Previous or Next buttons. 

 

Figure 48 – IR420 Location Data Display 
 
9.5 ADVANCED IR420 SETTINGS 
9.5.1 ENGINEERING UNITS 

Often the user may wish to report the readings directly in engineering units, rather than mA-units.  
Data required for the conversion to engineering units is always found on the calibration sheets for the 
transducer. 

Each transducer is shipped from the factory with a calibration sheet.  If you have not received a 
calibration sheet, or the sheet has been lost, please contact RST Instruments and a copy will be 
faxed or e-mailed to you. 

Engineering units conversion settings can be modified using the Eng Calibration dialog box shown in 
Figure 49. Access to this dialog box is provided from Edit Location dialog box. 
 
Conversion Method 

The user is given two options to apply a Linear Conversion: 

- Coefficient Input, enter Calibration Factor BM and Zero Reading CZ. 

- Range Input.  Input current and engineering calibration limits into appropriate boxes. 

The option is also given to modify the sensor offset. 

Equation used for calculations is shown for a reference. 
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Figure 49 – Engineering Units settings 
 

Important 

Whenever ANY changes are made on the Engineering Units screen or Edit Location dialog box, the 
Upload Site Info button must be pressed in order to update the readout with new information. 
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10 LP100 READOUT 
10.1 CREATING LP100 LOCATIONS 

Right-click anywhere in the blank workspace to create a new location or click on Add Location toolbar 
button. 

 

 

Figure 50 – Creating a New LP100 Site 
Click on New Location and the following dialog box will appear: 

 

Figure 51 – Naming LP100 Location 
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Enter in an appropriate location name.  In this example the location is: LP2011-BA.  The location 
name can be any alpha-numeric character up to 20 characters long.  This allows the option of 
entering a detailed name.  Optionally, each sensor can have individual name and serial number. 

Important 
Location name, sensor label and sensor serial cannot contain any comma (“,”) characters. Using 
comma characters in any label string would interfere with CSV data file formatting. 

 

The Eng Calibration and Advanced functions are explained in section 10.5 Advanced settings. 
Subsequent Locations can be created by repeating the above procedure. 
 

 

Figure 52 – Creating LP100 Locations 
Figure 52 shows five locations which have been created and contain no current or historical readings.  
These locations still need to be uploaded to the readout device at this stage. 

In order to delete any existing location, put a checkmark in first column checkbox and click Delete 
checked toolbar button. 

Current locations and configuration can be saved to ini file for future use or upload to the readout. 
Choose Save As.. from File menu to save currently displayed locations to site configuration file.  
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10.2 UPLOADING LP100 SITE INFO 
For the following procedures, it is assumed that the readout has established a successful connection 
to the host computer and the status Connected is displayed on the status bar.  

The following steps will clear Readout data memory and prepare Readout for next data 
collection in field. Therefore ensure that any existing data was exported to csv data file. 
(section 12.1.2).  
Click on Upload Site Info to upload the current information from the RST Readout Host software to 
the readout.  Upon uploading the data, the program will prompt you to if you would like to erase the 
current data on the readout.  In the normal progression of the program, erasing the existing data is 
the appropriate step. The latest recorded value from each location is saved as Previous Record 
Value.  

 

 

Figure 53 – Uploading LP100 Sites 
Note 

Always press the Upload Sites button before exiting the program as this ensures that data will not 
be duplicated in the subsequent *.csv file.  If no changes have been made to the setup, select NO 
when the program prompts you to save changes to the *.ini file. 

 
Once the custom user-defined locations are uploaded, the readout is ready to be taken out to the 
field to record data. 
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10.3 DOWNLOADING LP100 DATA 
Once the readings have been taken in the field, the data must be downloaded to the host software.  
Connect the readout to the Computer via the USB cable.  Launch the software and connect to the 
readout (section 3). 

 

 

Figure 54 – Downloading LP100 Data 
Upon connection, the software will automatically prompt the user to download and save the data.  To 
perform a manual download press the Download Data button in the toolbar.  

Note 
Downloaded data is not automatically saved into the data file by host computer. It is highly 
recommended to export data into csv file, as prompted by the host software. This will ensure that 
data is not accidentally erased from readout resulting in data being lost. 
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10.4 VIEWING LP100 DATA 
Once the data has been downloaded, the workspace becomes populated with all the information as 
found on the readout. 

 

Figure 55 – Downloaded LP100 Data 
As shown above, the data is populated and includes Location label, Previous Record Date/Time, 
Previous Record Value, Units and Number of saved readings for each location.   
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10.4.1 VIEWING LP100 LOCATION READINGS 
A complete listing of readings for selected location can be seen by clicking on the Display Records 
button in the toolbar. The sample data is shown below. This is the data currently contained on the 
readout itself, not necessarily all the historical data you might have for that location.  The scroll bar at 
the right of the screen permits the user to scroll and view all the readings for a particular location. To 
quickly jump to viewing another location, click on Previous or Next buttons. 

 

Figure 56 – LP100 Location Data Display 
 
10.5 ADVANCED LP100 SETTINGS 
10.5.1 ENGINEERING UNITS 

Often the user may wish to report the readings directly in engineering units, rather than %-units.  Data 
required for the conversion to engineering units is always found on the calibration sheets for the 
linear potentiometer. 

Each potentiometer is shipped from the factory with a calibration sheet.  If you have not received a 
calibration sheet, or the sheet has been lost, please contact RST Instruments and a copy will be 
faxed or e-mailed to you. 

Engineering units conversion settings can be modified using the Eng Calibration dialog box shown in 
Figure 57. Access to this dialog box is provided from Edit Location dialog box. 
 
Conversion Method 

The user is given two options to apply a Linear Conversion: 

- Coefficient Input, enter Calibration Factor BM and Zero Reading CZ. 

- Range Input.  Input % and engineering calibration limits into appropriate boxes. 

The option is also given to modify the sensor offset. 

Equation used for calculations is shown for a reference. 



RST Readout Host Software Instruction Manual 

RST Instruments 

58 

 

Figure 57 – Engineering Units settings 
 

Important 

Whenever ANY changes are made on the Engineering Units screen or Edit Location dialog box, the 
Upload Site Info button must be pressed in order to update the readout with new information. 
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11 C109 READOUT 
11.1 CREATING C109 LOCATIONS 

Right-click anywhere in the blank workspace to create a new location or click on Add Location toolbar 
button. 

 

 

Figure 58 – Creating a New C109 Site 
Click on New Location and the following dialog box will appear: 

 

Figure 59 – Naming C109 Location 
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Enter in an appropriate location name.  In this example the location is: BM2006-ba.  The location 
name can be any alpha-numeric character up to 20 characters long.  This allows the option of 
entering a detailed name.  Optionally, each sensor can have individual name and serial number.  

Important 
Location name, sensor label and sensor serial cannot contain any comma (“,”) characters. Using 
comma characters in any label string would interfere with CSV data file formatting. 

 

Subsequent Locations can be created by repeating the above procedure. 
 

 

Figure 60 – Creating C109 Locations 
Figure 60 shows five locations which have been created and contain no current or historical readings.  
These locations still need to be uploaded to the readout device at this stage. 

In order to delete any existing location, put a checkmark in first column checkbox and click Delete 
checked toolbar button. 

Current locations and configuration can be saved to ini file for future use or upload to the readout. 
Choose Save As.. from File menu to save currently displayed locations to site configuration file.  
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11.2 UPLOADING C109 SITE INFO 
For the following procedures, it is assumed that the readout has established a successful connection 
to the host computer and the status Connected is displayed on the status bar.  

The following steps will clear Readout data memory and prepare Readout for next data 
collection in field. Therefore ensure that any existing data was exported to csv data file. 
(section 12.1.2).  
Click on Upload Site Info to upload the current information from the RST Readout Host software to 
the readout.  Upon uploading the data, the program will prompt you to if you would like to erase the 
current data on the readout.  In the normal progression of the program, erasing the existing data is 
the appropriate step. The latest recorded value from each location is saved as Previous Record 
Value.  

 

 

Figure 61 – Uploading C109 Sites 
Note 

Always press the Upload Sites button before exiting the program as this ensures that data will not 
be duplicated in the subsequent *.csv file.  If no changes have been made to the setup, select NO 
when the program prompts you to save changes to the *.ini file. 

 
Once the custom user-defined locations are uploaded, the readout is ready to be taken out to the 
field to record data. 
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11.3 DOWNLOADING C109 DATA 
Once the readings have been taken in the field, the data must be downloaded to the host software.  
Connect the readout to the Computer via the USB cable.  Launch the software and connect to the 
readout (section 3). 

 

Figure 62 – Downloading C109 Data 
Upon connection, the software will automatically prompt the user to download and save the data.  To 
perform a manual download press the Download Data button in the toolbar.  

Note 
Downloaded data is not automatically saved into the data file by host computer. It is highly 
recommended to export data into csv file, as prompted by the host software. This will ensure that 
data is not accidentally erased from readout resulting in data being lost. 

 



RST Readout Host Software Instruction Manual 

RST Instruments 

63 

11.4 VIEWING C109 DATA 
Once the data has been downloaded, the workspace becomes populated with all the information as 
found on the readout. 

 

Figure 63 – Downloaded C109 Data 
As shown above, the data is populated and includes Location label, Previous Record Date/Time, 
Previous Record Value, Units and Number of saved readings for each location.   
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11.4.1 VIEWING C109 LOCATION READINGS 
A complete listing of readings for selected location can be seen by clicking on the Display Records 
button in the toolbar. The sample data is shown below. This is the data currently contained on the 
readout itself, not necessarily all the historical data you might have for that location.  The scroll bar at 
the right of the screen permits the user to scroll and view all the readings for a particular location. To 
quickly jump to viewing another location, click on Previous or Next buttons. 

 

Figure 64 – C109 Location Data Display 
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12 IR5000 READOUT 
12.1 CREATING IR5000 LOCATIONS 

Right-click anywhere in the blank workspace to create a new location or click on Add Location toolbar 
button. 

 

 

Figure 65 – Creating a New IR5000 Site 
Click on New Location and the following dialog box will appear: 

 

Figure 66 – Naming IR5000 Location 
Enter in an appropriate location name.  In this example the location is: BM2006-ba.  The location 
name can be any alpha-numeric character up to 20 characters long.  This allows the option of 
entering a detailed name.  Optionally, each sensor can have individual name and serial number.  



RST Readout Host Software Instruction Manual 

RST Instruments 

66 

Important 
Location name, sensor label and sensor serial cannot contain any comma (“,”) characters. Using 
comma characters in any label string would interfere with CSV data file formatting. 

 
The Eng Calibration and Advanced functions are explained in section 12.5 Advanced settings. 
Subsequent Locations can be created by repeating the above procedure. 
 

 

Figure 67 – Creating IR5000 Locations 
Figure 60 shows five locations which have been created and contain no current or historical readings.  
These locations still need to be uploaded to the readout device at this stage. 

In order to delete any existing location, put a checkmark in first column checkbox and click Delete 
checked toolbar button. 

Current locations and configuration can be saved to ini file for future use or upload to the readout. 
Choose Save As.. from File menu to save currently displayed locations to site configuration file.  
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12.2 UPLOADING IR5000 SITE INFO 
For the following procedures, it is assumed that the readout has established a successful connection 
to the host computer and the status Connected is displayed on the status bar.  

The following steps will clear Readout data memory and prepare Readout for next data 
collection in field. Therefore ensure that any existing data was exported to csv data file. 
(section 12.1.2).  
Click on Upload Site Info to upload the current information from the RST Readout Host software to 
the readout.  Upon uploading the data, the program will prompt you to if you would like to erase the 
current data on the readout.  In the normal progression of the program, erasing the existing data is 
the appropriate step. The latest recorded value from each location is saved as Previous Record 
Value.  

 

 

Figure 68 – Uploading IR5000 Sites 
Note 

Always press the Upload Sites button before exiting the program as this ensures that data will not 
be duplicated in the subsequent *.csv file.  If no changes have been made to the setup, select NO 
when the program prompts you to save changes to the *.ini file. 

 
Once the custom user-defined locations are uploaded, the readout is ready to be taken out to the 
field to record data. 
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12.3 DOWNLOADING IR5000 DATA 
Once the readings have been taken in the field, the data must be downloaded to the host software.  
Connect the readout to the Computer via the USB cable.  Launch the software and connect to the 
readout (section 3). 

 

Figure 69 – Downloading IR5000 Data 
Upon connection, the software will automatically prompt the user to download and save the data.  To 
perform a manual download press the Download Data button in the toolbar.  

Note 
Downloaded data is not automatically saved into the data file by host computer. It is highly 
recommended to export data into csv file, as prompted by the host software. This will ensure that 
data is not accidentally erased from readout resulting in data being lost. 
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12.4 VIEWING IR5000 DATA 
Once the data has been downloaded, the workspace becomes populated with all the information as 
found on the readout. 

 

Figure 70 – Downloaded IR5000 Data 
As shown above, the data is populated and includes Location label, Previous Record Date/Time, 
Previous Record Value, Units and Number of saved readings for each location.   
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12.4.1 VIEWING IR5000 LOCATION READINGS 
A complete listing of readings for selected location can be seen by clicking on the Display Records 
button in the toolbar. The sample data is shown below. This is the data currently contained on the 
readout itself, not necessarily all the historical data you might have for that location.  The scroll bar at 
the right of the screen permits the user to scroll and view all the readings for a particular location. To 
quickly jump to viewing another location, click on Previous or Next buttons. 

 

Figure 71 – IR5000 Location Data Display 
 
12.5 ADVANCED IR5000 SETTINGS 
12.5.1 ENGINEERING UNITS 

Often the user may wish to report the readings directly in engineering units, rather than %-units.  Data 
required for the conversion to engineering units is always found on the calibration sheets for the 
linear potentiometer. 

Each potentiometer is shipped from the factory with a calibration sheet.  If you have not received a 
calibration sheet, or the sheet has been lost, please contact RST Instruments and a copy will be 
faxed or e-mailed to you. 

Engineering units conversion settings can be modified using the Eng Calibration dialog box shown in 
Figure 57. Access to this dialog box is provided from Edit Location dialog box. 
 
Conversion Method 

The user is given two options to apply a Linear Conversion: 

- Coefficient Input, enter Calibration Factor BM and Zero Reading CZ. 

- Range Input.  Input % and engineering calibration limits into appropriate boxes. 
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The option is also given to modify the sensor offset. 

Equation used for calculations is shown for a reference. 

 

Figure 72 – Engineering Units settings 
 

Important 

Whenever ANY changes are made on the Engineering Units screen or Edit Location dialog box, the 
Upload Site Info button must be pressed in order to update the readout with new information. 
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13 FILE TYPES 
13.1.1 CONFIGURATION FILES (*.INI FILES) 

The RST Readout Host software creates a *.ini file when locations are created and saved into file.  
This is the equivalent of a configuration file and is used both in the host software and the readout unit 
itself.  If you have multiple readout boxes all being downloaded on the same computer, keeping 
separate configuration file for each readout greatly aids in keeping the appropriate data organized. 

13.1.2 DATA FILES (*.CSV FILES) 
Whenever the connection to the readout is established, or Download Data button is pressed, the 
software will collect all the current data stored in the memory of the readout.  A progress bar will be 
displayed showing the status of this collection. 

It is highly recommended to save data into csv file as soon as data is downloaded from the readout 
box. Either follow the prompt, or save csv file manually by clicking on Export csv file button, or 
choose Export to csv file from File pull down menu. The software will write the data to a *.csv file in 
the directory selected in Host Software Options. The default directory is: 
 My Documents\XXXXdata. 
Depending on file saving options, the user is prompted for data filename or file is saved 
automatically. With automatic filename option,  data is appended to existing file or unique filename is 
created. The unique data filename format is: 
XXXXdata_yymmdd_hhmmss.csv. 

The XXXX represents readout type. 
This file can then be opened directly with Microsoft Excel™ or other popular spreadsheet programs.  
The file header is created only at the first download and contains Readout status data. 

 

Note 
The *.csv cannot be open in Excel at the same time the RST Readout Host Software is running.  To 
ensure the program does not become unstable, close the RST Readout software and then open the 
appropriate files in Excel. 

 

When opened with Excel, the file has the following format: 
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Figure 73 – Sample Data File 
 

Note 
When sensor reading is outside of the valid range, the “99999” value will be recorded as the  
 data value. 

 

The data format will depend on Readout type, all readout types will have ID, Location Name, 
Date/Time, followed by recorded values.  This data can easily be sorted in Excel and plotted.  To sort 
in Excel: 

• Highlight all the data. 

• Under the Data menu, choose Sort.  The following screen will appear: 

• The data can be sorted as shown in Figure 66.  Column A = Ascending and Column C = 
Ascending.  This will sort all locations by their ID and will place them in the order from oldest 
to newest.  Conversely, the data could be sorted descending in time if required (i.e. Column 
C = descending).  

Readout site data 

Location Name 

Date/Time 
Readings Temperature 

Readings in 
eng units 
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Figure 74 – MS Excel Sorting 
 

• Highlight the desired cells and plot the data using the Chart Wizard. 

Note 
It is always good practice to create backups of your data.  When finished manipulating the data in 
Excel, save your work in *.xls format.  This ensures that the original *.csv format is not changed, 
and any plots which have been created will be preserved. 



RST Readout Host Software Instruction Manual 

RST Instruments 

75 

14 OPTIONS 
14.1 OPTIONS DIALOGS 
14.1.1 READOUT OPTIONS 

Once a connection has been established between the readout and the Host Software, the status of 
the device can always be checked.  Under the Readout menu, choose Readout Options and the 
following screen will appear: 

 

Figure 75 – Options Screen 
The Readout Options screen allows viewing and modification of the readout settings.  Most of the 
items are self-explanatory. 

The status of the following Readout components is displayed: 

Readout Battery 
The battery level should be monitored periodically to ensure uninterrupted operation in the field. 
Batteries should be replaced when voltage level drops below 3.5 Volts. 

Readout Stats 
This area shows the Readout serial number, firmware version, number of days since the last power-
on and the last assigned location ID. 

Readout Memory Stats 
The number of uploads and memory fills are shown for reference. 
Parameters in white windows can be changed and updated by pressing the Update Readout button 
at the bottom of the screen. 
The following settings can be modified: 

Readout clock 
The internal Readout clock can be adjusted manually or synchronized with computer clock. Click 
Sync to computer date / time to synchronize Readout internal clock with computer clock. To make 
clock adjustment automatic each time readout is connected to host computer, check Auto sync date / 
time checkbox. 
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Logger Label 
When several Readout boxes are used, the Logger label can be used to maintain control over data 
sets. The logger label is recorded in “csv” file after each data download. 

Temperature Units (VW2106, TH2016, MA7 Readouts only) 
Temperature can be displayed in Centigrade or Fahrenheit. 

Power Down, Backlight On Time 
To minimize power consumption, the readout powers down after chosen preset time. Backlight On 
Time can be adjusted to suit preferences. 

Speaker On Time (VW2016 Readout only) 
The build-in speaker will be activated for preset number of readings. 

Default Factor G (QB120 Readout only) 
If necessary, modify the default Multiplier Factor G used for Linear Conversion into engineering units. 
 

Note 
When configuration changes are complete, press Update Readout button to transfer new option 
settings to the readout memory. 

 

14.1.2 HOST SOFTWARE OPTIONS 
The RST Readout Host software options can be customized by accessing Host Software Options 
dialog from File menu.  

 

Figure 76 – Host Software Options Screen 
As shown on Figure 68, the following are editable settings: 
 
CSV Data File Folder 
The location of data file directory. Configuration ini files and data csv files are saved in CSV Data File 
Folder, unless other location is specified in file save dialog box. The Base Folder can be modified 
using Browse button. Initially, Base Folder setting points to user’s My Documents\ folder. 
 
CSV Data File Options 
The Host Software can append readout data to a new or existing file. Alternatively, the options are 
given to prompt for file name or create unique filename each time readout data is saved. The unique 
data filename format is: 
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XXXXdata_yymmdd_hhmmss.csv. 
The XXXX represent readout type. 
This file can then be opened directly with Microsoft Excel™ or other popular spreadsheet programs. 
Date and time can be recorded in data files using several formats. Choose desired format using the 
combo box. 

Note 
After changing the date and time display format, reload data from the readout to activate the new 
format. This is global setting, date and time in all csv formatted datafiles will be recorded using 
this format. 

 
CSV Data File Save Options 
Upon connection to the readout, data is automatically downloaded to Host Software. To disable this 
feature, uncheck the Auto download data checkbox. 
 
Sample Delay (TH2016 Readout only) 
Set the default TH2016 sample delay to be used when creating new locations. This value is initially 
set at 0.4 seconds. The sample delay range is 0.2 to 51 seconds, with even fractions allowed only. 
 

14.1.3 LOGGING OPTIONS 
Selecting the Logging Options in Readout menu opens the following window: 

 

Figure 77 – Logging Options Screen 
Using the Logging Options screen the logging settings can be adjusted.  The maximum continuous 
logging interval is 1 hour. The readout will continue logging data until Logging Number is reached or 
the logger memory becomes full. Enter “0” in Logging Number field to keep logging until logger 
memory becomes full. 

If sensors take some time to warm up, uncheck Sensors Always Powered On and select desired 
warm up time. 

Click Update Readout to transfer any edited settings to connected readout. 



RST Readout Host Software Instruction Manual 

RST Instruments 

78 

14.1.4 READOUT MONITOR OPTIONS 
The real time output of a vibrating wire sensor is monitored by the readout. To view the units and 
sensor settings for the monitor display choose Readout Monitor Options from Readout pull down 
menu. (Figure 70). 

 

Figure 78 – Monitor Options settings 
Note 

Readout Monitor Settings can be imported from any predefined location using the readout, please 
refer to the Readout Instruction Manual for further information. 

 
 
14.2  MENU ITEMS 
14.2.1 MAIN MENU 

New: Creates a new blank Readout Host Screen.  The user can then add new locations by right-
clicking the blank workspace (Figure 1). 

Open: Opens an existing configuration file (*.ini) which contain existing locations settings. 

Save: Saves the current working file to disk under the current filename and path. 

Save As…: Saves the current working file to disk and allows the user to choose a path and filename. 

Export csv file: Write all downloaded data to a csv file. 

Quick Print: Prints the current workspace as it appears on screen. 

Print Preview: display the active workspace as it would appear when printed  

Print Setup: specify the printer and its connection. 

Host Software Options: Modify Host Software settings. 

Exit: Exits the RST Readout Host Software 

14.2.2 CLIPBOARD MENU 
Cut: Cut the current selection in the location listing and put it on the clipboard. 

Copy: Copy the current selection to the clipboard. 

Paste: Paste the clipboard to the workspace. 
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14.2.3 VIEW MENU 
Status Bar: Hides/Reveals the Status Bar 

Gridlines: Hides/Reveals the Gridlines in the workspace. 

14.2.4 READOUT MENU 
Reconnect: Reconnects to the readout. 

Logging Options: Opens the Logging Options setup screen (section 13.1.2). 

Readout Options: Opens the Readout Options setup screens (section 13.1.1) 

Monitor Options: Allows editing of Readout Monitor units and conversion parameters (section 13.1.4). 

14.2.5 INSTRUMENT MENU 
Download Data: Downloads data from the readout (section 4.3, 5.3, 6.3, 7.3, 8.3, 9.3,10.3,11.3,12.3). 

Upload Sites: Uploads the current site parameters to the readout (section 4.2, 5.2, 6.2, 7.2, 8.2, 
9.2,10.2, 11.2, 12.2). 

Display Records: Display records for selected location. 

Add Location: Add new location. 

Export csv: Write all downloaded data to a csv file. 

Delete Selected: Delete locations indicated with check box mark. 

14.2.6 WINDOW MENU 
Manages open windows. 

14.2.7 HELP MENU 
Help Topics: Opens the Help Topics software help menu. 

Manual: Opens the software manual. 

About RST Readout Host: Displays the program version/revision number. 
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15 USB TO UART CONTROLLER DRIVER SET INSTALLATION – 
READOUT ID UP TO AND INCLUDING VR0459 OR TR5451 

Note 
This chapter is for VW2106 and TH2016 Readout. For other instruments, please refer to section 
15 for further information. 

 

Note the serial number on sticker underneath readout lid. Skip to section 15 if the serial number is 
VR0460 or greater, TR5451 or greater. For other instruments USB driver installation, skip to section 
15. 

The RST Readouts requires a set of drivers installed on the host computer in order to communicate 
over USB communication port. All steps must be completed for USB communication to work 
correctly. 

It is recommended to install the drivers from Microsoft Windows Update if internet connection is 
available. This will ensure the most up to date drivers are used. Just connect the RST Readout to 
desktop or laptop PC using included USB cable. Follow onscreen prompts for easy installation. 

In case internet connection is not available, use the included CD. Current USB drivers and software 
can be also downloaded from RST Instruments website http://www.rstinstruments.com. 

The following outlines a procedure for installing the USB to UART Controller Driver Set on 
Microsoft™ WindowsXP, Microsoft™ Windows Vista and Microsoft™ Windows7 platforms. The 
actual screenshots may differ but the steps will be very similar. 

15.1 MICROSOFT™ WINDOWSXP INSTALLATION PROCEDURE 

15.1.1 USB TO UART DEVICE INSTALLATION 
The following instructions contain VW2106 dialog screen shots. TH2016 dialogs will be very similar. 

After successful installation of RST Readout Host software, click on "First Gen Driver Install" in RST 
Instruments->RST Readout Host->Tools. The following screen will be shown: 

  

Figure 79 – First Gen Driver Set Installation on Windows XP 
 

Click Install… and press OK when installation finishes.  

At this time, Windows system detects installed device and starts New Hardware Wizard, as 
displayed in Figure 72 
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Figure 80 – New Hardware Wizard for Device 
Choose No, not this time if asked whether or not connect to Windows Update. Click Next. 
 

 

Figure 81 – New Hardware Wizard for Device – choose install 
 

Choose Install from a list or specific location and click Next. 
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Figure 82 – New Hardware Wizard for Device – Choose Driver 
 

Select Don’t search and click Next. Click Next on window that follows. 

 

Figure 83 – New Hardware Wizard for Device – Continue 
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Figure 84 – New Hardware Wizard for Device – File Transfer 
The Wizard will install device drivers and display the following screen. Click Finish to complete 
device drivers installation. 

 

Figure 85 – New Hardware Wizard for Device – Install Complete 

15.1.2 USB TO UART CONTROLLER INSTALLATION 
After successful installation of USB to UART device drivers, the readout should be connected to the 
host computer. Press any key on the readout to power up the unit, if not already done so. The MS 
Windows system should detect the new device and display New Hardware Wizard, as shown on 
Figure 78. 
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Figure 86 – New Hardware Wizard for Controller 
Installing USB to UART Controller device drivers procedure is very similar to the previously 
described steps for installing USB to UART Device drivers. Figure 79 through Figure 82 show 
every step for a reference. 

 

 

Figure 87 – New Hardware Wizard for Controller - Choose Install 
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Figure 88 – New Hardware Wizard for Controller – Choose Driver 
 

 

 

Figure 89 – New Hardware Wizard for Controller – File Transfer 
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Figure 90 – New Hardware Wizard for Controller – Install Complete 
 

After successful installation, the yellow message balloon (Figure 83) should be shown in the 
lower right hand corner stating that all device drivers are installed and ready to use. 
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Figure 91 – New Hardware Installed Confirmation 
Alternatively, correct installation of the device drivers can be verified by navigating to the Windows 
Control Panel, choosing System and then selecting the Hardware tab.  Clicking on Device Manager 
will bring up the following screen: 

 

Figure 92 – WindowsXP Device Manager 
If the driver was installed correctly, the RST VW Readout VW2106 USB to UART Controller port will 
appear as in Figure 84 above.  If the driver has not been installed correctly, yellow exclamation mark 
will appear next to the device.  Once the above has been verified, note the COM number which has 
been assigned to the USB serial port.  This will vary from computer to computer, in this example it is 
COM5. 

Close the device manager and launch the RST Readout Host Software. The RST Readout Host 
Software should now connect to the readout.  Confirmation can be made by looking at the status bar 
(Figure 1). 
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15.2 MICROSOFT™ WINDOWS VISTA AND WINDOWS7, 8.1, 10 INSTALLATION 
PROCEDURE 

The following instructions contain VW2106 dialog screen shots. TH2016 dialogs will be very similar. 

After successful installation of the RST Readout Host software, click on "First Gen Driver Install" in 
RST Instruments->RST Readout Host->Tools. The following screen will be shown: 

 

Figure 93 – First Gen Driver Set Installation on Windows Vista and 7, 8.1, 10 
Click Install… and then press OK when installation finishes. 

 

Figure 94 – Install Complete 
After successful installation of USB to UART device drivers, the readout should be connected to the 
host computer. Press any key on the readout to power up the unit, if not already done so. The MS 
Windows system should detect the new device and display hardware installation status, as shown on 
Figure 87. 

 

Figure 95 – New Hardware Status for Controller 
After successful installation, the yellow message balloon (Figure 88) should be shown in the lower 
right hand corner stating that all device drivers are installed and ready to use. 
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Figure 96 – New Hardware Installed Confirmation 
Alternatively, correct installation of the device drivers can be verified by navigating to the Windows 
Control Panel and choosing System.  Clicking on Device Manager will bring up the following screen: 

 

Figure 97 – Windows Vista and Windows 7, 8.1, 10 Device Manager 
If the driver was installed correctly, the RST VW Readout VW2106 USB to UART Controller port will 
appear as in Figure 97 above.  If the driver has not been installed correctly, yellow exclamation mark 
will appear next to the device.  Once the above has been verified, note the COM number which has 
been assigned to the USB serial port.  This will vary from computer to computer, in this example it is 
COM3. 

Close the device manager and launch the RST Readout Host Software. The RST Readout Host 
Software should now connect to the readout.  Confirmation can be made by looking at the status bar 
(Figure 1). 
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16 USB TO UART CONTROLLER DRIVER SET INSTALLATION – 
READOUT ID VR0460 OR GREATER, TR5452 OR GREATER, ALL 
OTHER RST READOUTS 
For VW2106 or TH2016, note the serial number on sticker underneath readout lid. Go back to 
section 14. if the serial number is VR0459 or less, or TR5451 or less. For other RST Readouts USB 
driver installation, follow the instructions below. 

The RST Readouts require a set of drivers installed on the host computer in order to communicate 
over USB communication port. All steps must be completed for USB communication to work 
correctly. 

It is recommended to install the drivers from Microsoft Windows Update if internet connection is 
available. This will ensure the most up to date drivers are used. Just connect the readout to desktop 
or laptop PC using included USB cable. Follow onscreen prompts for easy installation. 

In case internet connection is not available, use the included CD. Current USB drivers and software 
can be also downloaded from RST Instruments website http://www.rstinstruments.com. 

The following outlines a procedure for installing the USB to UART Controller Driver Set on 
Microsoft™ WindowsXP, Microsoft™ Windows Vista and Microsoft™ Windows7 platforms. The 
actual screenshots may differ but the steps will be very similar. 

16.1 MICROSOFT™ WINDOWSXP INSTALLATION PROCEDURE 
The following instructions contain VW2106 dialog screen shots. Other instruments dialogs will be 
very similar. 

After successful installation of the RST Readout Host software, click on "Second Gen Driver Install" 
in RST Instruments->RST Readout Host->Tools. The following screen will be shown: 
 

  

Figure 98 – Second Gen Driver Set Installation on Windows XP 
 
Click Next. 
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Figure 99 – New Hardware Wizard for USB to UART 
 

Select your acceptance of RST Instruments End User License Agreement, click Next. 
 

  

Figure 100 – New Hardware Wizard for USB to UART – File Transfer 
 

The Wizard will install device drivers and display the following screen. Click Finish to complete 
device drivers installation. 
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Figure 101 – New Hardware Wizard for USB to UART – Install Complete 
 
After successful installation of USB to UART device drivers, the readout should be connected to the 
host computer. Press any key on the readout to power up the unit, if not already done so. The MS 
Windows system should detect the new device and display the yellow message balloon (Figure 94) in 
the lower right hand corner stating that all device drivers are installed and ready to use. 
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Figure 102 – New Hardware Installed Confirmation 
Alternatively, correct installation of the device drivers can be verified by navigating to the Windows 
Control Panel, choosing System and then selecting the Hardware tab.  Clicking on Device Manager 
will bring up the following screen: 

  

Figure 103 – WindowsXP Device Manager 
If the driver was installed correctly, the RST Readout USB to UART Controller port will appear as in 
Figure 103 above.  If the driver has not been installed correctly, yellow exclamation mark will appear 
next to the device.  Once the above has been verified, note the COM number which has been 
assigned to the USB serial port.  This will vary from computer to computer, in this example it is 
COM3. 

Close the device manager and launch the RST Readout Host Software. The RST Readout Host 
Software should now connect to the readout.  Confirmation can be made by looking at the status bar 
(Figure 1). 
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16.2 MICROSOFT™ WINDOWS VISTA AND WINDOWS7, 8.1, 10 INSTALLATION 
PROCEDURE 

The following instructions contain VW2106 dialog screen shots. Other RST Readouts dialogs will be 
very similar. 

After successful installation of RST Readout Host software, click on "Second Gen Driver Install" in 
RST Instruments->RST Readout Host->Tools. The following screen will be shown: 

 

 

Figure 104 – Second Gen Driver Set Installation on Windows Vista and 7, 8.1, 10 
Click Next, the following dialog appears: 
 

 

Figure 105 – USB to UART Driver Set Installation 
 

Select your acceptance of RST Instruments End User License Agreement, click Next. 
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Figure 106 – USB to UART Driver Set Installation – File Transfer 
The Wizard will install device drivers and display the following screen. Click Finish to complete 
device drivers installation. 

 
 
 

 

Figure 107 – USB to UART Driver Set Installation – Install Complete 
 

After successful installation of USB to UART device drivers, the RST Readout should be connected 
to the host computer. Press any key on the readout to power up the unit, if not already done so.  
The MS Windows system should detect the new device and complete the USB serial port installation, 
as shown on following dialogs: 
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Figure 108 – USB Serial Port Driver Installation 
 

 

Figure 109 – USB Serial Port Driver Installation Complete 
 

Click Close and MS Windows will display the yellow message balloon (Figure 110) in the lower right 
hand corner stating that all device drivers are installed and ready to use. 

 

Figure 110 – New Hardware Installed Confirmation 
Alternatively, correct installation of the device drivers can be verified by navigating to the Windows 
Control Panel and choosing System.  Clicking on Device Manager will bring up the following screen: 
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Figure 111 – Windows Vista and Windows 7, 8.1, 10 Device Manager 
If the driver was installed correctly, the RST Readout USB to UART port will appear as in Figure 103 
above.  If the driver has not been installed correctly, yellow exclamation mark will appear next to the 
device.  Once the above has been verified, note the COM number which has been assigned to the 
USB serial port.  This will vary from computer to computer, in this example it is COM3. 

Close the device manager and launch the RST Readout Host Software. The RST Readout Host 
Software should now connect to the readout.  Confirmation can be made by looking at the status bar 
(Figure 1). 
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17 TROUBLESHOOTING 
1. Cannot connect to the RST Readout: 

Most of the connection problems are caused by incorrectly installed USB to UART Driver Set.  

a. Please ensure that the drivers are installed by navigating to the Windows Device Manager 
and verifying that the USB to UART Controller appears under Ports(COM & LPT) as shown in 
Figure 84 – WindowsXP Device Manager in Section 14.1.2 or in Figure 97 – Windows Vista 
and Windows 7, 8.1, 10 Device Manager. 

b. Select Edit and Port  and ensure that the COM port number match the COM port number 
assigned to the USB to UART Controller in Windows Device Manager. 

c. Verify that the USB cable is plugged into USB port on host computer and USB socket on the  
readout box. 

d. Check to ensure that no other software is using the USB port 

e. Turn off the readout and close the RST Readout Host software. Turn on the readout box, 
wait until startup logo screen disappears and start the RST Readout Host software. The LCD 
screen should display “Host connection” when connected to host computer. 

2. Program Crashes: 

a. Ensure that a *.csv is not open in Excel while trying to change the configuration of the 
readout in the software.  Close the software before opening any *.csv files. 

b. Don’t interrupt the program when it is downloading or uploading data. Wait until the progress 
indicator disappears from the status bar. 

3. Toolbar buttons and pull down menus are disabled – not accessible: 

a. Disconnect the USB communication cable from the readout. Connect back USB cable. The 
software will reinitialize and restart. 
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18 CONTACT US 
For sales information contact: sales@rstinstruments.com 

For technical support contact: rst_support@rstinstruments.com 

Head Office: 

11545 Kingston St 
Maple Ridge, BC 
Canada   V2X 0Z5 
 
Our office hours are:  8:30am – 5:00pm PST 

Monday – Friday (excluding holidays) 
 

Telephone:   604-540-1100 
Facsimile:   604-540-1005 
Toll Free:   1-800-665-5599 
Website:   www.rstinstruments.com 

mailto:sales@rstinstruments.com
mailto:support@rstinstruments.com
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